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This Quick Start Guide to the TRIUMPH-LS contains the
basic information a user new to J-Field, the field software of
TRIUMPH-LS and VICTOR-LS, needs to know to get started
working quickly. It is important that new users to J-Field
read and understand the information in this manual before
attempting to use J-Field. To obtain good results and RTK
solutions, it is most critical to understand the RTK
Verification and Validation process and settings. More
information and details are provided in the User’s Guide to
the TRIUMPH-LS. J-Field also contains its own evergrowing on-board manual with context sensitive help files
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Anatomy - Exterior of TRIUMPH-LS

Anatomy - Exterior of TRIUMPH-LS

Top, Left and Front Faces

Warnings - Press when
the warning LED is red to
view warning messages

Help - learn more
about the current
screen

Lock - lock the
screen to prevent accidental
actions

Screen - Cycle the screen to
Interference - Spectrum white or black backgrounds for
analyzer to check for
better visibility in the sun
interference in the
GNSS bands
Print Screen - Capture
a screenshot

Bottom, Right and Back Faces

A/V - Control
sounds, volume
and display
brightness

Battery - status
of the battery
and internal
temperatures
Optional shoulder
strap connection
plug

Stop - Stop the
collection of a
point

Start - Start the collection
of a point
Navigation
buttons

Check - Used to open or
select the current item/box

External GNSS
antenna port

Battery status
LED
Home - Press to return to
the Home screen

Warning LED / Battery LED
(when off and charging)

Internal Radio
Antenna

Micro SD card slot

Factory port
covers

Internal GSM
Antenna

Micro USB Port - This is for
connecting the Triumph-ls
to a computer. Use the
provided cable.

WiFi / Bluetooth
Antenna

Charge Status
LED

External UHF
antenna port

Zoom In / Advance
to the next page/
screen

Action - Open the Stake Action screen
/ Expand White Box buttons
Zoom Out / Advance to the
previous page/screen
RS232 port

Speaker

High resolution
capacitance
color touch
screen

SIM CARD Slot 1
USB Port - Use this port for connecting USB storage drives and dongles
to the TRIUMPH-LS. This is not for
connecting the TRIUMPH-LS to the
computer.

SIM CARD Slot 2

Headset

LAN port
Slant height
measurement
point

Speaker

Charging port
Setup - Cycle between
the Setup and Advanced
Setup screens
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User Defined ButtonsCustomizable to invoke desired actions
/ functions

Collect - Cycle
through the collect
screens
Stake - Cycle through
the stake screens

On/Off - Turn on
the unit, hold down
if the system is
unresponsive

Mute - Mute
the sound

Built in
Microphone

Light
sensor

Proximity
sensor

Serial number of
the TRIUMPH-LS

Slant height
measurement
point
Bottom
Camera

Light - Turn on/off the
flashlight
www.javad.com
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x 20
threads

Flashlight

Front
Camera
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Screen Anatomy - Home Screen 1

UHF antenna 400-470 MHz,
2.5dB, RT Angle, SMA (optional,
if UHF module is installed)

TRIUMPH-LS

GNSS Interference, the numeric
value is the maximum magnitude
of interference among all the GNSS
bands

AC Power Cable

Satellites, number of tracked
satellites are shown above the icon
and the Receiver Name is shown
below

Ext Power/Charger
Click any icon in the top row to
open its status screen

AC Power Adapter

LAN

WiFi

UHF

GSM

BT

Battery - The estimated hours : minutes of remaining battery life is shown below
Setup Summary, the
setup profile name is
displayed below

Volume
Localize - Create localized coordinate systems

Inactive connections are gray
and active connections are blue
Collect - Survey points

Points -List the project points and polylines

Stake - Stake points and
lines

Files - Browse the file system, import and export
files
ShapeTags & Codes - Manage ShapeTags, Codes

Setup - Configure the
setup profiles

rd
n co
nsio
Exte cluded
in
not
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Support - menu, used to
request support and install
updates.

CoGo - Various CoGo Functions,
DPOS and Camera Tools

Power Cable

Coordinate Systems - lists all the system coordinate systems, not used to set the current coordinate system

Updates available

RAMS Connection
Established

Messages Available

Charging kit

Shown assembled while the TRIUMPH-LS is being
www.javad.com
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Screen Anatomy - Home Screen 2

System - Receiver details and
information, etc.

Language - Specify the
language

Timing - Configure clock
display format, set alarms,
schedule data collection

Charging the Batteries
The TRIUMPH-LS AND VICTOR-LS come from the factory
with the batteries charged and ready to use so you can
begin exploring its interface and familiarizing yourself right
away while reading this manual.

Base/Rover Setup - Start a
RTK base station with a UHF
or SS radio

Camera - Capture photos with the
front and bottom cameras

Calendar - Manage survey
projects by date

Interference - Complete GNSS
spectrum analyze

Voice Recorder - Record audio
notes

Calibrate - Calibration for the level
and compass

Previous Screen - Advance to the
Home Screen 1

Anytime the TRIUMPH-LS displays
this LED as red, press the warnings
key to learn more and take any
necessary corrective measures.

Help & Support

Locks - Prevent inadvertent
screen interactions

Data Exchange - Export / Import
various data formats

Calculator - Several
different calculators
are available

Tap to open the
Timing screen

Next Screen - Advance to the
Home Screen 1

Lithium Ion batteries should not
and cannot be charged when
their temperature is above 40° C (104° F).
They charge faster when they are cool.
Therefore, it’s best that you turn off the
unit when charging. Charging the unit
when it’s on will cause it to charge more
slowly (up to 40° C) due to its increased
temperature.

Some of the cables and their
connectors used in charging
the equipment may not be
familiar to you. ODU style
connectors are superior for a
broad range of industrial
power,
communications
and
data
applications
that demand a precisionengineered, secure and
robust solution.

When charging your receiver, be sure to line up the red
dots on the connector and the charing port on the LS. Note
8
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that the four LEDs have different
meanings when the LS is on from
their meanings when the unit is
being charged. When the unit is
on, you’ll want to pay attention to
the upper left LED as it alerts you of
an immediate issue.

www.javad.com

J-Field contains its own ever-growing on-board manual
with context sensitive help files for various screens. Press
the hardware Help button to learn more about each screen.
Contact information of the Live Technical Support team
members are listed in Support>Live Technical Support. You
are also encouraged to submit your feedback and questions
to the user’s forum located at http://support.javad.com.

Turning on The TRIUMPH-LS
Powering the TRIUMPH-LS on is pretty straightforward
with the underlying operating system; Windows Embedded
Compact 7.0, loading first and then J-Field
subsequently booting up.
There are occasions when the system
might freeze. Should you experience this,
simply depress the power key and hold
down until the unit powers off, about 10
seconds. Any data collected up to that point will be saved.
9

Calibration
The TRIUMPH-LS is an
advanced scientific surveying
instrument.
It is highly
sensitive to its environment
and includes a built-in
magnetometer and 3-axis accelerometer.
For the visual stakeout features and the Ahead/Back
and Right/Left White Boxes in the Stake Action screen to
work correctly, the electronic compass readings need to
be accurate. It is recommended to check the compass
calibration before beginning work at a new location. To
check the calibration, rotate the TRIUMPH-LS 360° and
observe the compass readings in the Collect or Stake
Action screen. There should be no twitching, quick jumps,
or reversals of the displayed bearing or azimuth, just as a
real compass would perform. If this is not the case, the
compass needs to be recalibrated or it may not be in a
suitable environment for its use. Follow the instructions on
the screen to calibrate the compass. When calibrating the
compass, choose an area removed from overhead power
lines, parked automobiles and other ferrous materials which
cause magnetic disturbance. The electronic compass works
in areas that are electromagnetically uniform.
The Level calibration typically only needs to be preformed
once. Follow the instructions on the screen to calibrate the
level.
The level sensors are sensitive to the internal temperatures
of the TRIUMPH-LS. To fine tune the level calibration, a
Level Offset calibration needs to be preformed. It is located
in the Action Setup menu. It is necessary to reperform this
calibration as the internal temperature of the TRIUMPH-LS
changes. If the Correct For Tilts option is enabled and the
10

most accurate positions are desired, it is essential to monitor
the Level Offset calibration and recalibrate when necessary.

with the update symbol (cloud and
down arrow) and a sound will be played
periodically when a new update is
available.

The Camera needs to be calibrated if you intend to use the
camera’s Visual Angle or Camera Offset Survey tools. This
only needs to be done once.

Tap on this icon to review
points, alignments, trajectories
in J-Field.

Keeping your TRIUMPH-LS
up to date is nearly effortless;
however, you do need to
ensure that you have Internet
access in order to download the firmware and software
updates.

If you do not have WiFi or for some reason are unable to
connect to it, but do have a wired local area network, you
can connect the TRIUMPH-LS to your network using a cable
connected to the LAN port and your network interface card
or router. A wireless network can also be used if you have an
installed SIM card data plan with sufficient data.
Once connected to the Internet, J-Field will automaticaly
check for updates. The Support button will be displayed
www.javad.com

•

Points

Updates

The TRIUMPH-LS will automatically detect nearby WiFi
networks. To see the detected networks, as well as their
respective signal strength, tap on the WiFi icon in the top
row of icons on the Home screen and then at the bottom of
that screen tap on Network. Select the desired access point,
tap on Connect, enter the case sensitive password, if any,
and the connection should be established. Once
connected to a WiFi network it will be remembered
and added to the Favorites and the connection to it
will become automatic when it is detected.

•

•

Base Station Coordinates - When a point is surveyed
with RTK corrections, the base station coordinate is
saved.
Survey Shifted Coordinates - When a point’s base
station coordinates have been adjusted or shifted, the
shifted survey coordinates are displayed along with
the unadjusted survey coordinates (Survey Origin).
Base Station Shifted Coordinates - When a point’s base
station coordinates have been adjusted or shifted, the
shifted base station coordinates are displayed along
with the unadjusted base station coordinates (Base
Station Origin).

Points Screen Displaying Design Points
Each point record can have up to five types of coordinates
that are displayed in the Edit Points screen:

Edit Point Screen Displaying a Point with Each Type of
Coordinate

In addition to these coordinate types, all post-processed
Design Coordinates - Imported and manually entered DPOS and Real-Time Shifted coordinates are also stored in
coordinates are populated into this field and stored in the database. These will be discussed more in the DPOS
the Project’s database file with their native coordinate section of this manual.
system as was selected when they were imported.
•
Survey Coordinates - These are coordinates determined
from GNSS observation. All surveyed points are stored
with Survey Coordinates with WGS84 (ITRF 2008)
coordinates.
www.javad.com
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Screen Anatomy - Points Screen
Object Type - The radio button selects which type of
object is displayed in the list: Survey Points , Design
Points, Polylines (and lines) or Trajectories.
Add - The add button allows new points to be added;
with the Survey option selected you will be taken to
the Stake Action screen.

Point Filters

DPOS - The DPOS button opens the DPOS screen that allows raw GNSS data to be
submitted to the JAVAD Data Processing Service. Base station data can be processed
with CORS data to obtain real geodetic positions and rover data can be processed
with both the base station data and CORS data.
Photo, Screenshots, Audio & Notes - These buttons
are active when a point has photos, screenshots,
audio or notes associated with it. Tapping these
buttons will preview the associated file.

Processed Point Info - This button opens the Processed Point
Info screen. Here post-processed coordinates from DPOS can
be compared to RTK coordinates and the desired coordinate
can be selected for every point.

Edit - The edit button opens the Edit
Points screen (shown on the previous
page) to allow the various parameters of
the point to be modified.

Points are displayed in the coordinate system of the Current
Page in the CoGo functions and in the map. All new
Survey Points and points created with the CoGo functions
are created in the Current Page. The Current Page can be
selected by tapping
(Filter Button) to open the Filter
screen. The First row displays buttons for each of the 10
pages. The Current Page is highlighted green while visible
pages are shown with bold numbers and hidden pages
are shown with small gray numbers. Tap a page button to
toggle it between visible and hidden. Objects in hidden
pages are not display in the list of objects or on the map.

The Current Page is set with the toggle on the left while the
visibility of Pages are controlled with the check box options
on the right.

Additional Actions - Various additional actions
are available from this menu (see following
the pages).

Delete - The delete button deletes the
selected object. A Long Click (tap and
hold) on this button deletes all objects
currently shown in the list, i.e. taking into
account the general filter and name filter.

The In All Projects toggle will display points from all projects.
This is usually not recommended as it will slow J-Field down
if many points exist.
Points can be sorted in the displayed points list by Distance,
Alphabetical or Chronological. Notice the down arrow in
the corner of the Distance Filter button. Holding this button
down will initiate a Long Click and present additional
options for the Distance Filter.

Esc - Escape to the previous screen
Filter - Filter button (see next page)

Point Information Panel - Information about the
selected point is displayed here. Alternative
templates for this panel are available by
choosing Additional Actions>Settings>Info.
The Default template is currently shown.
Tapping this panel opens the Base-Rover
Statistics screen.

Type Filter - Type Filter button (see
the following pages)
Name Filter - Name Filter button (see
the following pages)
List - Point Codes and Descriptions can be displayed beside the Point Name. Formating
options are found in Additional Actions>Settings>Columns>Name. Options also exist
here to display icons when the point is “Shifted” and when it has “JPS” GNSS data. The
“Type Filters” column option will display Solution Type, Process Type and Base Type
abbreviations beside the point names.
12

Pages Screen - Current Page is 1, Page 0 is hidden

Map- Opens the map with the currently
selected point highlighted in the map

Filter Screen - Current Page is 1, Page 0 is hidden
The Pages screen can be open by tapping Pages. It displays
the page names and allows it to be edited along with the
coordinate system and color.

Page Numbers - Chages which page of the list to view

Points

www.javad.com
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activate
and
searches for names which either
begin with the search string or contain it in the middle.
To search for a range of numbers use the format of
number1..number2. This format matches names which
contain numbers in range between number1 and number2
(in the position defined by switches). E.g. if you enter
3..9 (assuming all switches are on), it will match names 3,
Stake04a, Pt9, but not names 14 or Point19a.

Origin of Distance Filter Options

Type Filters Screen

Hide Staked hides points that have already been staked. A
point is considered staked after it has been staked with a
surveyed coordinate accepted for it.

The
(Name Filter) button enables/disables the name
filter. When it is on, four additional fields are shown to the

Hide Vertices hides points created from imported lines from
being displayed in the point’s list. J-Field defines lines as
connections between points so every line must have points
at its vertices. For this setting to be applied the Hide Line
Vertices option must be checked in the Common Settings
screen when AutoCAD, DGN or Shapefiles are imported.

right: one text field and three switches captioned

The
(Type Filter) opens the Type Filters screen. It
allows points to be filter by Solution Type, Processing Type
and Base Type.

string;

,
and
. Enter the search text in the text field
and specify which switches are active (activated switches
have a light blue background while deactivated switches
are white):

The
(Additional Actions) icon contains a list various
options, settings and functions related to the Points screen.
More information about the items contained in this menu
can be found in each of the actions’ Help screen. Of
particular interest are Settings and Cluster Average.

Additional Actions screen
The information panel (the right blue panel) may contain
more text than fits in its view. If this is the case, tap and drag
the panel to scroll its contents.

Settings has options to allow the Point Name, Code and
Description to all be displayed in the left panel of the Point
screen rather than just displaying the Point Name.
Cluster Average finds groups of points in a cluster and
creates an averaged point from the group.

looks for names which begin from the search

looks for names which contain the search string
in the middle, but do not begin or end with it;

looks for names which end with the search string.
Activating more than one switch combines the results:
14

Points

www.javad.com

www.javad.com

Points

15

Coordinate
Systems

is selected at the top of the screen, tap the
button to open the Coordinate System Catalog.

It is important to remember that GNSS distances measured
in State Place Coordinate Systems may not match measured
ground distances exactly and typically need to be scaled to
ground. For this reason you may wish to create an adjusted
grid-to-ground coordinate system. Alternatively, the CoGo
functions in J-Field have the ability to display and input
ground distances while still working in an unmodified State
Place Coordinate Systems (see the CoGo chapter of this
manual for more information).

(Add)

The
Coordinate Systems
screen allows you to quickly
access and create new
coordinate systems based on
the predefined systems with just a tap on this icon.
It is important to note that this screen does not set the
current coordinate system for the Project. To change a
Project’s coordinate system choose Project>Edit Current
Project>Project Coordinate System in the Stake and Collect
Prepare screens. Each page in the Project can then also
have separate coordinate systems, set from the Page and
Coordinate System boxes in these screens.

Creating an Adjusted Grid-To-Ground
Coordinate System
Select the appropriate Height System, Geoid, Input Epoch and
Transformation. A typical coordinate system configurations
for a US State Place Coordinate System is shown:
Coordinate System Catalog Screen
When selecting a Regional system for your project from the
vast catalog, filter the choices to just those relative to your
geographic location by checking the Near Me box. Select
your Region, Country and type of coordinate system:

With your state plane coordinate system selected in the
Coordinate System screen click the Additional Actions
button
and tap Duplicate to create a copy of this
coordinate system. The duplicated system will be created
with the date appended to the end of its name:

Coordinate System Screen

Adding a State Plane Coordinate System
To add a new coordinate system that is currently not listed
in the Coordinate System screen when the All Project button
16

Coordinate Systems

www.javad.com

For all surveying in the US, it is strongly recommended that
NAD83(2011) with Epoch 2010 be selected for all survey
work as this is the current supported realization supported
by NGS. The Gooid model should be “GEOID12B CONUS”
and HTDP transformations should be used for compatibility
with DPOS.
www.javad.com
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or Ppm:

Adjust Grid-to-Ground & Rename Screen
Now highlight the duplicated system and tap the
icon and choose Adjust Grid-to-Ground & Rename:

edit

Tap the Default button
to change the coordinate
system name to the default name:

Tap the position icon
beside East Origin to set origin
point in the grid system for the transformation. Here the
base station coordinate is chosen from the points List:
18

Coordinate Systems
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By default the ground origin point will be populated with
the same coordinate and the Scale Difference is populated
with the grid-to-ground scale factor calculated from that
point. The scale factor rounded to the nearest part-permillion (ppm) is automatically appended to the coordinate
system name:

You may also wish to round the scale difference to the
nearest ppm by tapping its button and entering that value.
In this screen options exist to enter a new factor as a Ratio
www.javad.com

The Factors button will allow you to use the CoGo Scale
Factor function to calculate a new scale factor if desired.
These settings will create an adjusted state plane coordinate
system scaled around the base station and the base station
coordinate will not change. This is useful for projects that
have ground distances as would be measured with a total
station and state plane coordinate system bearings since
the rotation is set to 0. The coordinates will be very close
to the real state plane system so that orthographic imagery
and state plane referenced contours or elevation models
can be loaded into your CAD drawings. You should be
cautious when giving these coordinates to others as they
may confuse them for real state plane coordinates. To
solve this problem you may wish to subtract 100,000 from
the North and East Ground coordinate values to create a
(100,000 100,000) offset from the real state plane system.
This can be done by tapping the North Ground and East
Ground boxes.

Tap the
Coordinate Systems

button to add the current project’s name to

19

Files and Data Exchange

the beginning of the coordinate system name:

Data transfers between the TRIUMPH-LS and your PC are
facilitated through using either a USB cabled connection,
a USB flash drive, a cloud drive or a network drive. Using
a cloud drive or USB flash drive are the simplest and
recommended methods to transfer data between your PC
and J-Field.

Database Structure and Customize
Screen
Each J-Field Project has a “data.db” file stored in its project
folder found in “Internal Memory\ VS Data\Maps”. All the
points and lines for a project are stored in this file. By default,
the Internal Memory is hidden. To allow it to be visible in
J-Field you can enable this option from System>Customize.

Press OK and then Apply to create this coordinate system:

Customize Screen

The Long Click Time setting in the Customize screen controls how long a button must be held down to register as
a Long Click. Some button in J-Field preform two actions
with the second action being initiated with a Long Click.
Buttons with these second actions typically display a small
down arrow in their bottom left corner.
Check the Double Vial Detector option if you are using the
Javad rover rod with a double leveling vial. This allows the
downward facing camera to detect both vials.

You can now use this coordinate system as the Project
Coordinate System or just for some Pages if you choose.

20
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Mounting a Cloud Drive

Mounting a Shared Network Folder

After signing in you will be prompted to Grant access.

Mounting a shared network folder allows files to be
transfered to and from J-Field while it is connected to
a local network. First a folder from a PC connected to
the same local network as the TRIUMPH-LS needs to be
created.

J-Field supports Google Drive and Dropbox cloud drives.

Once this is completed, return to your web browser and
select Cloud accounts in the left pane. Then click Connect
Google Drive or Connect Dropbox. You will be prompted
for your credentials for these accounts.
Files>Browse Files screen showing mounted Google Drive,
Dropbox and a shared network folder.
To mount a cloud drive navigate to https://app.javad.com/
jca/#/inventory/devices and login from your PC’s browser.
If you have not setup a Javad.com login, you will need to
do so.

Click Generate Key and a new alphanumeric key will
appear. In J-Field open System>Dropbox/Google Drive and
tap Handshake Key to enter this key. Then click Establish
Connection. Note that J-Field needs to have an Internet
connection established during this process.

After these steps are completed open Files>Browse Files
and click the context menu icon
and choose Mount
Cloud Drive. You should see your Google and Dropbox
accounts listed if you completed the previous steps
correctly. Choose the desired account and press OK.

Here the folder TriumphLS was created on the Desktop.
Right clicked on it, selected Properties and then enabled
Sharing in the Sharing tab.
Then in the Browse Files screen, choose Mount Network
Share from the File Operations menu when you are in the
System Root directory.

22
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Importing Points From a Text File
To import points from a text file open the Data Exchange
screen from the Home Screen 2 or from Files>Data Exchange.

Then enter the network path as shown above along with
your Windows account name and password.

Note that if an error message is received while trying to read
the network shared folder, it may be necessary to reboot the
TRIUMPH-LS to resolve this. This is a known issue with the
Windows operating system in the TRIUMPH-LS.

Open File Screen - Filtered to show only text files

Data Exchange Screen
Navigate to the location where your file is located using

If your text file is configured with the standard format of
“PointName, N, E, H, Description” you should configure the
import settings as shown below if they are not presently
configured this way. The preview should display if the
format is being interpreted correctly.

the
to go up a directory and Open to open a folder.
Then select and highlight the text file to open and choose
Open. (Notice the down arrow in the corner of the Navigate
Up button. Holding this button down will initiate a Long
Click and navigate to the system Root directory.)

Press OK and you should now see this folder shared in the
Root Directory where it can be used to import and export
files.
If the preview is correct, press Next.

24
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Exporting Points To a Text File

Use Export Range to choose which points to export.

To export points to a text file open the Data Exchange
screen and choose the Export option. Choose the format
of the file type you wish to export with the box in the lower
right corner, in this case Text/CSV. Navigate to folder you
wish to save the file. Click the Next button to proceed or
enter a new file name if desired. If you desire to change the
default filename of the file to be created, you may do so by
clicking on the filename box displayed to the right of Save
File in This Folder.
Export Formatting Screen with Default Formatting Shown

A summary screen will be displayed. The points will be
imported into the selected Page and be imported to
the coordinate system of that Page. Tap Import to finish
importing the points.

The plus and minus buttons are used to add and remove
fields while the up and down arrows will change the
order of fields. Presets allows configurations to be saved
and recalled. Options are displayed to set the number of
Decimals exported and whether to export a Header Line.
More Settings opens the Export CSV Settings screen where
options exist to specify how to format cut and fill values and
Surveyed Design Points.

What to Export Screen
After the settings and points to export have been selected,
tap Next to preview the formatting and points before
pressing Export to create the file.

Save File Screen - Set to save a txt file in the USB drive
The Export Formatting screen will be displayed. It should
have the default configuration to export a “PointName, N, E,
H, Description” file with the description field being a merged
field J-Field’s Code, Attributes and Description fields. These
fields are merged together with the use of Sep. 2 (Separator
2) set to be a space. By default, fields are separated with
Sep. 1, typically set to be a comma. Highlighting a field from
the box on the left side of the screen and tapping Sep. 2 will
add a plus sign after the field name to indicate that it will be
separated with Sep. 2.
26

Files and Data Exhange

www.javad.com

Export File Preview Screen
Export CSV Settings Screen
www.javad.com

Files and Data Exhange

27

ShapeTags &
Codes

Exporting Photos, Screenshots, GNSS
Data and Project Archives
To export media files that include photos, screenshots,
audio files and raw GNSS data files choose the Project
Archive File (ZIP) format option in the Save File screen. A
full Project Archive can also be exported with this option. A
Project Archive contains all the files necessary to restore the
project if it becomes corrupt or deleted. It can also be used
to copy the project to a different TRIUMPH-LS.

Export Project Archive Screen - Set to export only photos
(screenshots included) and raw GNSS files

Create and manage your
own library of Codes; alphanumeric textual assignments
to points. Codes can quickly be recalled from the Favorite
Codes screen, eliminating the need to type in a point
description for each surveyed point. In addition, each Code
can have up to five Code Attributes fields. An example of
a Code is “IPF” (Iron Pin Found). It can then be setup with
Code Attribute fields of “Size”, “Cap” and “Status” which allow
these attributes to be entered and stored with each point.
Choose Tags & Codes>Manage Codes to access the library of
Codes.

Exporting A Project Report

Save File Screen - Set to save a Project Archive file in the USB
drive

28
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Edit Code Screen
ShapeTags can be assigned to points during data collection
to enable the automated drawing of lines between points
with like ShapeTags. For example, you may want to create a
ShapeTag of “Fence”. When collecting a point along a fence,
select the “Fence” ShapeTag to be assigned with that point.
This will cause a line to be drawn on the map between
that point and the previous point that also has the “Fence”
ShapeTag.

A report of the Project can be exported in HTML or PDF
format by choosing HTML or PDF format in the Save File
screen. The report will contain the selected points with
all the details and statistics about that point. The Text &
Images will be included if this option is checked. A number
of options exist to format the PDF or HTML report:

After tapping Save File in This Folder or the New button you
will be presented with options to specify what type of files
to export in the Export Project Archive screen. Use the Full
option to create a backup that can be restored. The Only
Media option will export only the filetypes chosen. Press
Create to export the files which will all be contained in a zip
file.

useful with other software packages. The Category can be
used as a filter in the Manage Codes screen.

ShapeTags are associated with a chosen Code when a new
ShapeTag is created. When a ShapeTag is then selected to be
assigned to a point, by default, the Code field for that point
will be populated with the associated Code.

Manage Codes Screen
Tap Create or Edit to make a new Code or edit an existing
one. A Symbol, ID, Category and Code Description can be
assigned each Code. If a Symbol is associated with a Code,
points with that code will have the Symbol displayed on
the map. The ID field is a numerical field that is not used
in J-Field but is an export option for text files and may be
www.javad.com
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Setup
J-Field’s settings are divided
into 3 profile groups: the
General Group, Action Group
and Favorite ShapeTags and
Codes. These groups exist
so that different settings
groups can quickly and
easily be saved and recalled.
The General Group profile stores the settings for RTK
corrections, i.e. the configurations for UHF radios or
connection parameters to a RTN. The Advanced Settings are
also stored in the General Group and are found as an option
in the first setup screen of the General Group, they include
the settings for the displayed units. Tap Edit>Advanced to
access them.

The Favorite ShapeTags & Codes profile stores different list
of favorite ShapesTags and Codes.

General Group Profiles Screen

Setup Screen

The Action Group profile contains the collection settings.
These include the RTK Verification and Validation settings
and how many epochs to collect. These settings are
discussed in the Collect section of this manual. The
configuration of the Stake and Collect Action screens’ User
Defined (whitebox) Buttons are stored in the Action Group
profile as well as the U1-U4 hardware button options.

Setup Favorite ShapeTags & Codes Screen

The
(Set Up) will quickly open the Setup screen;
pressing it twice opens the Advanced Settings Screen.
As an example, to configure a new RTN setup you would
tap Create to create a new General Group profile and then
follow the screen prompts to enter the communication
parameters and settings. See Appendix A: Creating a RTN
Profile for detailed instructions on setting up a RTN. Copy
As creates a copy of the existing profile but prompts you to
enter a new name for the new profile.

30

Advanced Settings Screen
Tapping the Recall / Manage button will open a list of
profiles shown on the left side of the Profiles screen. Details
of that profile are displayed in the information panel (the
blue box on the right side of the screen). Across the top
from left to right are buttons to Rename, Delete, Search,
Sort Alphabetically, Sort by Date.

Setup
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Once a UHF or FH915 SS General Group profile has been
created and recalled, tap the Base/Rover Setup button from
the second page of the Home screen.

Base/Rover Setup

Setup Screen - Creating a new General Group profile
Enter a profile name (“UHF” or “FH915 SS” are suggested) in
the next screen and tap OK. The next screen will prompt
you to select the Operating Mode, choose RTK Rover:

Base/Rover Setup
Base/Rover Setup is used to configure and start the
transmission of RTK corrections via UHF or FH915 SS
(frequency hopping spread spectrum) radios from your
Javad Base receiver and radio to your Rover. It reads the
communication parameters from a UHF or SS General Group
rover profile and creates a matching base station profile
internally. It then sends that base station profile to the base
through the Bluetooth connection.

If for some reason the selected profile is not in UHF or FH915
SS mode a message will be displayed indicating so.
Should that be the case, tap Recall to select a UHF or FH915
SS radio profile or tap the displayed message to change the
current General Group profile into a UHF or FH915 SS profile.

To connect the Base and the Rover via Bluetooth, tap
on Connect. The external radio, if using one, should be
powered on prior to pressing Connect. Always have an
antenna connected to the radio before powering it on to
avoid potential damage to the radio.

Before Base/Rover Setup can be used a UHF or FH915 SS
General Group rover profile is needed. If one does not exist
yet, open the Setup screen and tap Create for a new General
Group profile:
You could tap Next and continue to configure all the
communion parameters but this is not necessary as they
can also be configured with Base/Rover Setup. Press Back
and then Esc to return to the Home screen.
32
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Immediately a scan of available Bluetooth devices will
begin and a few seconds later will be completed. If a base
station is found that has been previously used, J-Field will
automatically connect to it. If not, you will be presented
with a list and must choose the device intended to be used
as the Base receiver and tap Connect.

Tapping the left panel opens the screen to configure the
radio parameters. “RTCM 3.0 Min” Format should be used
to minimize the correction data that must be sent through
the radio.
To use 5 Hz BEAST MODE the Broadcast Period must be
changed to 0.2 seconds or Use Data UpSampling must
be enabled in the Advanced Setup menu (discussed at the
end of this section). It is important to note that increasing
the Broadcast Period, increases the battery consumption
of the radio as well as the heat generation inside it. With
the HPT435BT you may need to use the modem fan when
broadcasting with an output power greater than 4 watts
with 5 Hz corrections, depending upon the ambient
temperature. Data UpSampling is now preferred over 5
Hz corrections as it increases battery life and range of the
radios and decreases the heat generated from the radios.

Once the Bluetooth connection has been initiated, it will
take a few seconds before it has completed. During that
interim few seconds, your screen may appear like what is
shown on the right.

UHF Base Configuration Screen

The Base ID field limits the Rover from receiving corrections
if the Base and Rover profiles do not have the same Base ID.
It can be left at its default value of 0.
Transmit L2C is always enabled. If for some reason it is not
checked, it will become enabled automatically when the
Base is started with Base/Rover Setup.

Once the existing Base and radio parameters have been
retrieved the screen should look similar to this. The Rover
profile radio parameters are displayed on the left panel while
the current Base coordinate is displayed on the right. Radio
parameters displayed in red indicate that there is a different
value between the Base and Rover profile. Use From Base to
update the Rover profile to the parameters from the Base or
use To Base to send the Rover radio parameters to the Base
before starting the Base.
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To configure the UHF or FH915 parameters tap the UHF or
FH915 Configuration button.
FH915 SS Base Configuration Screen
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Tapping the UHF or FH915 Configuration button will
trigger an immediate search for the radio via Bluetooth
between the Base and the radio. If a Bluetooth enabled
radio is not found to be currently paired to the Base, you
will be prompted to pair the radio. This can be done via
the Bluetooth option if the radio is currently not paired to a
base. If the radio was previously paired to a base, it would
need to be unpaired before it could be paired to another
base through the Bluetooth option. The USB option can
be used to pair a radio that is currently paired to a different
base by connecting the ratio to the TRIUMPH-LS through
the USB port.

height 4 m (13.1 ft), D16QAM modulation and a 1 watt
output power, 5 Hz RTK corrections can have a stable range
up to 4 km (2.5 miles) away when terrain obstacles do not
block the signal. A hill or ridge between the Base and Rover
will greatly limit the range. The FCC (US) allows up to 35
watts ERP (Effective Radiated Power) to be transmitted. If
you have a HPT435BT radio set to output 35 watts and are
using an antenna that isn’t a unity gain antenna, such as the
5 dBd gain whip antenna, you aren’t in conformance with
the FCC regulations and terms of your license. With the 5
dBd gain whip antenna, an Output Power of 10 watts or less
must be used to stay under 35 watts ERP.

For UHF radios the parameters shown to the right need
to be configured. The Frequency should be one of your
FCC licensed (US users) frequencies. A channel with
little interference should be chosen. From the Frequency
selection screen you can Scan the displayed channels to
check the interference levels.

Your FCC assigned call sign should be entered in the Call
Sign box.

A Modulation (the method the data is encoded in the radio
signal) must be selected that has a sufficient link rate to
transmit the corrections. In the US Channel Bandwidth is
limited to 12.5 kHz the FCC and D16QAM modulation must
be used with a 5 Hz correction rate (0.2 second broadcast
period). D8PSK modulation should be used if the radio is
transmitting at 1 Hz. Modulations with greater link rates
have decreased receiver sensitivity to demodulate the
signal and the downside to choosing modulations with
higher link rates is that they are more subject to interference
and data loss when the signal is weak. Field test have found
that D16QAM modulation decreases the working range
of the radio approximately 20% as compared to DQPSK
modulation.

The Unpair button is used to unpair the Bluetooth
connection between the base and Rover. This would only
be necessary if you wish to pair a different radio to your
Base.
Update FW checks and installs the latest radio firmware.
FH915 SS Radio Settings
With a FH915 SS radio Packet Repeating must be disabled
when using correction rates greater than 1 Hz.
UHF Configuration Screen

In the US it may be best to operate on Channel 7 to avoid
interference.
Field test confirm 4 km (2.5 miles) as the range at which
stable 5 Hz RTK can be achieved with a FH915 SS radio with a
4 m (13.1 ft) antenna height. With 2 m you may achieve up to
2 km (1.2 miles), but it is dependent upon the environment.

Increasing the Output Power increases radio range but
also increases radio power consumption. With an antenna
36
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Return to main Base/Rover Setup screen by tapping OK
twice. Press To Base to send modified parameters to the
Base. After doing this all the parameter values should be
yellow.

In this screen you can enter / change the name of the point
being used as the base; to do so, tap Stored Point Name
and enter the desired name. It is recommended the Project
Name being included in the point name so that the file can
easily be identified in the DPOS tool.

The Base broadcast coordinate should now be set. Tap on
the coordinate pane on the right side of the screen.

Confirm sending the coordinates to the Base with a tap on
Yes, Store Point and Send to Base.

If the base is being started on a known point select that point
From List or Enter the coordinates manually; otherwise use
an autonomous position by tapping From Auto.
The parameters will be sent to the Base and radio and the
Base should begin to broadcast, typically after about 80
seconds.

The 2D Delta indicates the horizontal distance between the
current autonomous position the base is reporting and the
proposed broadcast coordinate.
Enter the Antenna Height and Offset. In this case the Base
is on a 2 m pole with the thread adapter that adds an
additional 0.025 m. Tap OK once done.
The base station raw GNSS data is always recorded and then
transfered to J-Field when Stop Base is pressed at the end
of a survey session so that it can be sent to Javad’s Data
Processing Online Service, also known as DPOS. With the
DPOS tool found in the CoGo menu and in the bottom of the
Base/Rover Setup screen, the raw data file can be submitted
to DPOS and all the survey points from that base station
session can be adjusted to their real coordinates so they are
no longer based off an autonomous position. The recording
interval can be specified along with some DPOS options
with the Rec box.

The
(transmitting) icon will indicate when the Base
is transmitting and OK will be displayed to the right of it.
Similarly, the
(receiving) icon will indicate when the
Rover is receiving data. If the icon bars are red (as shown
with one red bar), this indicates that the radio transmission
is over powering the receiving radio and that the Rover
is too close for set Output Power. If the broadcast is too
overpowering, corrections will be lost and the link quality
will drop.

Once the coordinates for the Base have been selected/
entered along with Antenna Height and radio parameters
tap Start Base.
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5 Hz BEAST MODE and Data UpSampling

Once the Base is broadcasting you can check that the Rover
is correctly receiving corrections at the set transmission
rate. Open the Collect or Stake Action screen. The position
solution button should display the correct incoming
correction rate and the communication button should
display a 100% link quality.

5 Hz BEAST MODE processes the RTK data and seeks a fixed
solution at a 5 Hz rate. Most RTK systems with update rates
greater than 1 Hz still only fix the ambiguities at a 1 Hz
rate but then once a fixed solution is obtained, the data is
extrapolated to get positioning rates of up to 100 Hz. When
good data is being received by the base and the rover,
the time required to acquire a fix is inversely proportional
to the rate of the ambiguities are being processed. By
reducing the time for the RTK engines to fix with 5 Hz BEAST
MODE processing, RTK Verification and Validation can be
completed much quicker and surveyors can collect points
in locations that previously proved to be very difficult and
time consuming.

To check that you have started the Base correctly with the
correct coordinate, you may wish to stake a point you have
previously located if you have one available.

After the Base has been started you can press Done to
disconnect the bluetooth or alternatively the connection will
be disconnected when the distance between the Base and
Rover exceeds the range of the Bluetooth communication.

Javad GNSS has recently developed a proprietary
Upsampling process that allows 1 Hz base data transmissions
to be upsampled to 5 Hz data for use with 5 Hz BEAST
MODE processing. Now the ambiguities can be resolved at
a 5 Hz rate even when the base is only transmitting 1 Hz
data. This Use Data UpSampling option is found in Setup >
Edit (General Group) > Advanced > RTK/DGPS. You can also
press the Setup hardware button twice to quickly enter the
Advanced Setup menu and then open the RTK/DGPS settings
screen. Enable the Use Data UpSampling option and set
the RTK Rate to 0.2 seconds to use 5 Hz BEAST MODE with 1
Hz corrections. These settings can also be used with an RTN
transmitting corrections at 1 Hz.

After finishing surveying return to the Base again and
open Base/Rover Setup to Connect again and stop the
base with Stop Base. This will display a prompt to stop
the data transmissions and download the Base GNSS data
into J-Field. Choose Stop & Download. After the download
completes the Base can be powered off, the radio can be
powered off while the data is downloading without causing
any problems.

Managing Base Files
Base files can be deleted from the base or manually
downloaded into J-Field. From the Base/Rover Setup screen
choose the
Files option.
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Troubleshooting Starting the Base
If for some reason problems are encountered when trying
to start the Base, clearing the Base NVRAM is usually the first
recommendation.
How to clear the NVRAM
1. Turn the receiver OFF with the ON/OFF button.
2. Press and hold the Record button.
3. Turn the receiver ON by pressing the ON/OFF button.
4. Wait until all the LEDs are flashing yellow (except the
battery LED).
5. Release the Record button.
If the radio is transmitting, its TX LED should be flashing
at the broadcast rate. If the radio is broadcasting but
corrections are not being received in J-Field, check the UHF
Status screen for an “err” listed in the UHF State. If an error
state is displayed, press Restore CFG to restore the factory
UHF configuration.

button and then the Mange Base

Base/Rover Setup

Advanced Setup > RTK/DGPS screen - Settings for Data
UpSampling
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Collect
Pressing the Collect button
opens the Collect Prepare
screen; pressing Collect
hardware button twice
will open the Collect Action
screen.

The Project button displays the name
of the current Project. Tap it to open
an existing Project, to create a new
Project, or to edit the current Project’s
name or coordinate system.

The Page button displays the name of
the current Page. Tap it to open the
Pages screen and set the current Page,
turn on or off Pages or edit a Page
Name or coordinate system.

The Coordinate System button displays
the name of the coordinate system for
the current Page. Tap it to change this
coordinate system.
The Code button displays the name of
the Code that will be assigned to the
next surveyed point. Tap it to choose
a new Code from your list of Favorite
Codes.

ShapeTags can be assigned to points
during data collection to enable the
automated drawing of lines between
points with like ShapeTags. “DefTag”
is the default ShapeTag and does not
create lines between points.

In the Collect Prepare screen, the Project, Page, Coordinate
System, ShapeTag, Code, Code Attributes, Point Name, Point
Description, Antenna Height and collection settings can be
setup before beginning data collection for a point.
When collecting points, it is recommended to use the
Code and Code Attributes to store information about the
point being collected. The Description field can then be
reserved for entering additional information about the
point. When exporting point coordinates in Text/CSV
format, these three fields can be merged into one field so
that surveying software can import data with the traditional
“Name,N,E,H,Description” format but with the description
being the combination of J-Field’s Code, Code Attributes and
Point Descriptions fields.

Screen Anatomy - Collect Prepare Screen

which opens a screen to configure the collection settings
for points. The RTK Verification and Validation settings are
configured from Action Setup screen.

Up to five variable Code Attributes
fields can be used be used to store
additional information about a point
with this box.

Collect Prepare Screen
Pressing the Action hardware button or Next
from the Collect Prepare screen opens the
Collect Action screen.

The Point Name button displays the
name that will be assigned to the
next surveyed point. After a point is
surveyed it will increment to the next
available name.
The Review buttons opens the Review
screen which is a map of the project.
Here linework can be drawn on the map
with the CAD functions and point data
can be edited.

The View button opens a
screen to configure what point
Use the Point Description field to store attributes are displayed on the
additional information about the point. map and allows some graphical
parameters to be customized.

The Review buttons opens the Review screen which is a map
of the project. Here linework can be drawn on the map with
the CAD functions and point data can be edited.
The View button opens a screen to configure what point
attributes are displayed on the map and allows some
graphical parameters to be customized.

Edit the height of the ARP (Antenna
Reference Point).
Takes you to the Action screen

Displays the current Action Group profile name group and opens the Action
Setup screen. The rover icon displays
whether tilt corrections are enabled
or not (disabled above). The clock icon
indicates the How to Stop? setting has
been set to a fixed number of epochs.

Displays the estimated remaining
battery life and is a shortcut to
the Battery Status screen

To the right of the View button is the Action Setup button
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Action Profile Setup

is useful for changing the collection settings for different
environments and types of points that need to be collected.

The Action Setup screen can be opened by tapping the
bottom middle button on the Collect and Stake Prepare
screens. It contains all the settings related to the collection
of points.

If Activate Post-Processing is enabled, raw GNSS data will
always to be logged in the background when points are
collected. If an RTK solution has not been accepted or
rejected after the set period of time, a Save for PP option
will be presented during point collection to save the GNSS
data with the point for post-processing. Rover GNSS data
can also be submitted to DPOS if it is recorded with the
settings in What To Record.
How to Start Screen

Action Setup Screen - Recommended Settings for Multipath
Environments
There several different options to specify when data
collection for points starts and ends, the most commonly
used options being with the Start Button and after a
specified number of epochs have been collected. Using
a Start Delay may be useful if you need to collect a point
where you cannot reach the TRIUMPH-LS. You can press
Start and then set the TRIUMPH-LS up over the desired
point. The starting of data collection will be delayed by the
selected Delay period.
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Save for PP button displayed after a fixed solution was not
able to be collected.
How to Stop Screen - Recommended Settings for Surveying
Monuments in Multipath Environments with 5 Hz BEAST
MODE Corrections
What To Record presents options to automatically capture
raw GNSS data, camera images, voice recordings and
screenshots. To process rover data with DPOS, GNSS data
needs to be saved at 1 Hz.

Use Recall to quickly recall a saved Action Group profile. This
www.javad.com
Collect

www.javad.com

Collect

45

RTK Verification and Validation

complete.

It is very important that you read and understand the
information about RTK Verification and Validation
contained in this manual.

The Confidence Guard (CG) determines the size of the Group
or bucket. Each Group contains all the epochs located
within a specified radius (the CG value) from its center and
new Groups are created as necessary so that all epochs
fall into at least one Group. Each Group has its own Epoch
Counter, Confidence Level and Elapsed Time. A point may
fall into more than one group. The groups are sorted from
best to last by the sum of their Time and Confidence with the
current best group being shown within [ ] and others within
( ). Show on the Screen specifies how many groups will be
displayed on the plots on the screen. There is no limit to the
number of groups that will be stored internally but only up
to the best 6 will be displayed on the screen.

Verify Settings Screen - Recommended Settings for Multipath
Environments
When located in difficult environments and under tree
canopy, all GNSS receivers are prone to give bad fixed
solutions that may appear to be acceptable if they are not
verified. Existing methods to verify GNSS solutions include
“dumping” the receiver, turning it upside down to cause the
RTK engines to reset, and re-observing the point at a later
time.
J-Field automates these processes with its built-in software
features of Verify and Validate. Verify automatically resets
the RTK engines after every fixed epoch is collected in
Phase-1 of its process. Epochs are placed into Groups or
buckets during Phase-1. Once a Group has met the required
Confidence Level and Minimum Phase-1 Duration (time
between the first and last epoch in that group), Phase-1 is
46

During Phase-2 the engines are not reset and solutions
which are located inside the CG of the selected Group are
added to that Group for the remaining number of epochs
that user has requested (Epoch Number, EN) in the How to
Stop screen. Epochs which are outside the CG of the selected
Group will be stored in a new (or previously created) group;
the RTK engines are reset if the epoch falls outside a sphere
with a radius twice that of the CG. If the number of epochs
falling outside of the current group reaches 30% of epochs
collected so far, the process will revert back to Phase-1 and
the Confidence Level of the current group will be reset to
0. Previously created groups will remain intact and once
an existing or previously created group meets the Phase-1
criteria, it will pass to Phase-2.
Validation is the final phase of the process. With this
feature enabled the RTK engines will reset one final time
at the end of the observation and collect 10 additional
epochs. Allowing sufficient time between Phase-1 and
the final Validation step will guarantee a bad solution is
not allowed to be accepted. From extensive testing in the

Collect
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worst of multipath environments, a bad solution has yet
to be accepted when Verify and Validate are enabled with
a Minimum Duration of least 180 seconds. This will ensure
that at least two separate fixed initiations are acquired at
least 3 minutes apart. Having at least 2 fixed initiations in
agreement and acquired at least 2 to 3 minutes apart has
been found to be the critical requirement to ensure that
bad fixed initiations are not accepted. In high multipath
environments the Boundary Action Profile should be used
to meet this requirement and guarantee a good initiation.
You must let entire collection process complete.
Confidence Level and Consistency Level are counters; the
Confidence Level of a group increments each time an epoch
with a new RTK initiation (Fix) is collected. It increments by
values of 1, 1.25, 1.5, 1.75, 2.0, or 2.5 for 1 to 6 fixed engines,
respectively. The Consistency Level of a group increments
with every epoch collected by values of 0, 0.1, 0.25, 0.5, 1.0,
and 1.5 for 1 to 6 fixed engines. The set Consistency Level
must be met before Phase-2 is allowed to end.
If high accuracy is needed in areas of high multipath and
areas with limited views of open sky (under full tree canopy
and urban canyon environments), longer observations
will improve accuracy. Repeated observation can also
be performed later (1 hour or more is recommended) to
improve accuracy. These repeated points can then be
averaged together with the Average function found in Cogo
Tools or with the Cluster Averaging function.

Recommended Collection Settings &
Default Action Profiles
Boundary Action Profile - To be used for control and
boundary shots and in high multipath environments (under
tree canopy, next to buildings, etc.)
www.javad.com

 Start with Start Button
 Stop After: 100 epochs
 Minimum Duration: 120 seconds (increasing this
to 180 is preferred in bad locations for additional
protection from accepting points with bad fixed
initiations and for better post-processing results)
 Minimum Phase-1 Duration: 30 seconds
 Verify with V6 Reset
 Confidence Level: 10
 Consistency Level: 10
 Min RTK Engines: At least 2
 Validate Result: with at least 2 engines
 Correct for Tilts: Off (Rover pole must be plumbed)
Precise Topo - To be used for topographic shots where some
multipath may be present. The receiver should still have at
least a 50% clear view of the open sky.
 Start with Start Button
 Stop After: 10 epochs
 Minimum Duration: 10 seconds
 Verify with V6 Reset
 Confidence Level: 5
 Consistency Counter: 10
 Min RTK Engines: At least 2
 Validate Result: with at least 2 engines
 Correct for Tilts: Off
Quick Topo - To be used for rapid topographic shots in open
sky environments. If it is difficult to obtain 5 engine fixed,
the environment may not be well suited for this profile and
the Precise Topo profile should be used.
 Start with Start Button or Start When Tilted
 Stop After: 2 epochs
 Verify without V6 Reset
 Consistency Level: 0
 Min RTK Engines: At least 5

Collect
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 Correct for Tilts: On*
Stakeout - To be used for staking out points (See Stake
section of this manual). Staking point in areas of high
multipath still requires confirming matching fixed initiations
acquired at least 2 minutes apart. The Boundary profile can
be used for this. After the location of the point being staked
has been verified, Verify with V6 Resets can be turned off to
quickly fine tune the location of the point being staked.
 Start with Start Button
 Stop After: 30 epochs
 Minimum Duration: 30 seconds
 Verify with V6 Reset
 Confidence Level: 5
 Consistency Counter: 10
 Min RTK Engines: At least 2
 Validate Result: with at least 2 engines
 Correct for Tilts: Off

*If Correct for Tilts is on, the Level Offsets must be calibrated
frequently if accuracies greater than 0.10’ are needed.
If the point you are attempting to locate is near the edge
of a building, tree trunk or other obstruction, it often best
to use one of the CoGo Offset functions. When the most
accurate measurements are needed, the CoGo Resection
function found in the Intersections menu is recommended.

Instantaneous RMS estimate of the
current position solution
The current RTK correction rate being received
“FIX” (Fixed), “FLT” (Float), ”CDF” (WAAS Code
Differential Float) or “STN” (Standalone) solution types
are indicated. Tap this box to open the RTK V6+ screen..
Number of engines fixed/number of
engines required by user

Shortcut to the Action Setup screen;
the pitch (forward/back), roll (left/
right), and the azimuth or bearing
the unit is facing are displayed. This
box turns orange if the device is
tilted more that 5 ° with Correct for
Tilts off, or more than 30 ° degrees
with Correct for Tilts enabled. When
orange it prevents accepting of
epochs in all modes except trajectory.

Returns to the previous screen

Antenna Height

Shortcut to the Review screen

If you wish to review point statistics or if you wish to edit the
ShapeTag, Code, Description and/or Attributes fields after
data collection, Auto Accept must be set to Off. If these
fields do not need to be changed and you desire fast data
collection with the Quick Topo settings, set Auto Accept to
On.
Collect

Center map on current location

Cycle through AutoZoom and 1:1
Zoom modes
Zoom out

Begin collecting a point; the current
time is displayed on the 2nd line

D-SNR loss, displays the level (in dB) of
the signal strength loss and interference in the L1 / L2 GPS and GLONASS
bands. Values 0-3 are desirable, 3-6
are fair and above 6 are poor.

Maximizes map view to full screen

WAAS Float - This profile can be used to quickly collect
points with float solutions. SBAS tracking must be enabled
to acquire WAAS (Wide Area Augmentation System,
available in North America) float solutions. SBAS tracking
can be enabled from the Advanced Setup menu (press the
Set Up hardware button twice > GNSS).

Shortcut to the applicable RTK corrections communications screen; Currently corrections are
being received through WiFi with a 100% link
quality and full signal strength (as displayed by
the full bars of the signal strength icon)

Shortcut to Selection of the type of
feature being located; Point, Line
Curve, Trajectory or Shift; choose by
Survey or by Offset

Shortcut to Satellite Status screen;
displays the number of satellites
being used + the number of
additional satellites tracked but
not used

In all above cases
 Accept Fixed Only, RMS: All, PDOP: All
 Confidence Guard: 0.164 ft
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Screen Anatomy - Collect Action Screen

The map displaying point and lines
contained in pages that are enabled.
To expand the User Defined Buttons
press the Action hardware button.

Unassigned User Defined
Button, tap to assign

Zoom in, the scale is displayed as the
distance across the bottom of the
screen (between the user defined
boxes).
Current location in current Page
Tap once to preform the action
associated with the User Defined
Button (AKA White Box); long click
(touch and hold) to remove or change
the User Defined Button

* Total number of SVs obsered by RTK
Rover may be different from number
of SVs observed by RTK Base
www.javad.com
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Screen Anatomy - RTK V6

Screen Anatomy - Collect Action Screen
Screenshot after Phase-1 of RTK Verification is Completed

Time: Duration is seconds between the
first and last epoch collected
GNSS satellite
count used in
given engine
3D RMS for the current epoch
in given engine

GPS

A user definable threshold showing
allowable delay in seconds when
Extrapolation Mode is used .

GLONASS

Current
epoch count

Current
best
group
in [ ]

Current
other
groups
in ( )

Current
Target
confidence confidence
level
level

* At the end of Verify sets
values shown are the total
RMS of all sets

Number of seconds since the
last reset for a given engine
Horizontal (left) and vertical (right) plots of the
collected epochs. Each
Group has its own color.
These plots currently have
2 Groups.

Distance from the solution
of the 1st engine

Number of fixed solutions
since all engines were reset

Verify Statistics
# of Phase-1 Restarts, # of Groups

Use this value to evaluate and
compare the performance of
each engine.

# of Epochs outside the Confidence Guard
during Phase-2

Reset GNSS Tracking

Activate Post-Processing - 26 epochs
of raw data have been saved, 300
are required for the post-processing
option

Charts plotting each fixed
epoch for each engine
Scales of the plots
Horizontal Vertical

Manually reset engines to compel new fixed
solutions when automatic verification is
turned off (unchecked)

Coordinates of
current position

Example One: Phase-1 ONE
This Point was collected in a high multipath environment, several feet
away from a 2 story building.
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Screen Anatomy - Map Screen

Screen Anatomy - Collect Action
Screen with Expanded User
Defined Buttons

Screenshot after Phase-2 and Validation Phase of RTK Verification is Completed

Stake
Similar to the Collect Prepare
screen
in
appearance
and function, the Stake
Prepare screen allows you
to configure the settings for
staking points.

The User Defined Buttons are expanded by pressing the
Action hardware button. The most commonly used and
recommend User Defined Button options are shown
below:
Number of epochs used in final
position
Confidence Level
of the Point

Time between first
and last epoch in
seconds

Consistency Level
of the Point

HRMS and VRMS
of the Point in
units of 0.01 ft

Vertical Drift in mm per
minute (RMS of the
Vertical Drift)

Verify Statistics
# of Phase-1 Restarts, # of Groups
# of Epochs outside the Confidence Guard
during Phase-2

Many of the selected options are inputs for the same
parameters in the Collect Prepare screen. As with every
screen, more details can be found by pressing the Help
hardware button.
Final averaged
position of all
positions

Peak to peak distance
Horizontal Vertical
Current page’s linear units

Stake Prepare Screen
Additionally, the Prepare to Stake screen allows you to
define various Modes to stake which include a Points Mode,
several Alignment Points Mode and Alignment Stake-Here
Mode.
Sequence defines the order of the points to be stake. The
From Map mode is suggested mode for new users. This
allows you to pan the map cursor over a point displayed in
the map and tap Next to select that point to be staked.

Example One: Phase-2
This Point was collected in a high multipath environment, several feet
away from a 2 story building. The effect of multipath can be seen with the
large vertical spread displayed in the vertical plot.
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Real-Time Position Shift

the staked coordinate or Reject to discard them or to adjust
the position and try again.

Real-Time Position Shift, allows real-time corrections to be
applied to receive base station corrections. A base station
can be started with an autonomous position and then
corrected by surveying a point with known coordinates.
The known point could be a point previously surveyed with
a base station setup in a different location. This feature is
useful for several scenarios:
 You need to move or “leapfrog” your base station to extend the radio
range into a new area.
Stake Sequence Screen
The suggested User Defined Button options for new users
are displayed in the follow two screenshots.

Stake Action Expanded Screen
The CTT (Course to Target) Arrow User Defined Button option
in the top left box displays the direction to the point
being staked while the distance to it is displayed in the
DTT (Distance to Target) whitebox below it. Further down
are the Ahead/Back and Right/Left boxes that display the
distances to the point relative to the TRIUMPH-LS. The Cut/
Fill option is in the lower right box.
On the right side, the Target Name option is used as another
method to select the point being staked. When it is added
as a whitebox you must choose whether to “Key-in target
point name” or “Select target point from list”. Select the
option you prefer. Below it are Point Description, Accept As
and Verify Statistics whitebox options.

Stake Action Screen
When near the target point being staked tap Start to begin
collecting data and to average the displayed offset values.
When staking a point in a multipath environment, this is
an essential step that must be used with RTK Verification to
ensure the RTK initiation is correct. Choose Accept to store
54

Position Shift Screen

 Your original base station point has been lost.

The Accept As whitebox is useful if you wish to store the
staked coordinate of a design point as new point rather
than having it stored in the design point’s record. After
collecting the staked design point press Accept As rather
than Accept if you desire to store it as a new point.
www.javad.com
Stake

 You wish to save time by starting the base station with it mounted to
the top of your vehicle. Setting the base station and radio up on the
top of vehicle by mounting it a roof rack or using a magnet mount saves
time by eliminating the need to setup tripods and can help protect the
base station from disturbances or theft in undesirable locations. For the
best performance, the base station should be mounted in a near level
position so that phase center variations and antenna offsets are correctly
applied. If you are parked on a sloped surface, a swivel mount can be
used to level the receiver on the top of your vehicle. Your vehicle should
be parked on solid ground where it will not move or sink.
The Real-time Position Shift function can be accessed from
the Advanced Setup menu (press the Set Up hardware
button twice > Real-time Position Shift). In this screen,
select a point you have collected RTK coordinates from
with an autonomous base station and then the known
coordinates of this point. Check the Apply Shift and the shift
will be applied to all the RTK surveyed points found in the
current project collected from this base station. This shift
will continue to be applied to all the points surveyed from
this base station.
www.javad.com

Real-time Position Shift can also be accessed from the Collect
Action screen by clicking the button below the Start button
and changing the collection mode to Shift. In this mode
select the Known Point and then press Start from the action
screen to collect a point so that the offset can be calculated.
After it has been calculated you will be prompted to apply
the shift.

Position Shift Screen from the Collect Action Screen

Real-Time Position Shift
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Hybrid RTK with DPOS
When a GNSS RTK base station
is started by assuming an
autonomous position, it is
necessary and good practice
to later adjust and correct
the coordinates with a GNSS
solution referenced from known
coordinates.
J-Field, has the
ability to adjust the base station
coordinates and associated
RTK points surveyed with DPOS
(Javad’s Data Online Processing
Service). Your raw GNSS base
station data is sent to the DPOS
server from J-Field to be processed with CORS (Continuously
Operating Reference Station) data. DPOS then sends the
adjusted coordinate back to J-Field and J-Field applies the
adjustment to the base and rover coordinates.
Now with the introduction of Hybrid RTK in J-Field 2.0, raw
data files from the rover can also be post-processed with
DPOS. Your local base station data can be used to postprocess base to rover vectors; serving as an additional check
for the RTK solutions and as method to obtain accurate
solutions in areas where RTK corrections are lost. Rover
points with raw GNSS files can also now be post-processed
with CORS data.

Download so that the base data is downloaded into J-Field
and can later be processed with DPOS.

have been met the button changes to display
.
Then once Stop is tapped the PP Options button is displayed.

What To Record screen - Recording of GNSS Data enabled
Base/Rover Setup - Prompt to stop the base and download
data

Raw data for rover points can also be saved with the Activate
Post-Processing option found in the Action Setup screen.

You will be prompted with several options. Choose Stop &
Download so that the base data is downloaded into J-Field
and can later be processed with DPOS.

Collect Action screen displaying the PP Options button.
Tapping this button presents the options to save the raw
data for post-processing.

Rover GNSS data is recorded with points when this option is
enabled in the What To Record settings.

Action Setup screen - Activate Post-Processing option after 5
min

Recording Raw GNSS Data
Base station data is automatically recorded when a base
station is started with Base/Rover Setup. After done surveying
connect to base in Base/Rover Setup and choose Stop Base.
You will be prompted with several options. Choose Stop &
56

recorded and how many are required in the Collect and
Stake Action screens. Once the required number of epochs

Hybrid RTK with DPOS

When this option is enabled, the
(APP) button
will be display how many epochs of raw data have been
www.javad.com

www.javad.com

Collect Action screen displaying the prompt to save raw data.
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Hybrid RTK with DPOS

Note that as of J-Field 2.01.523, design points are not
adjusted but this feature is planned for the future. All
CoGo functions except Average create resultant points with
design coordinates.

Processing Raw Data with DPOS
To post-process the data, open the DPOS tool found in the
CoGo menu and select the base file you wish to process. It
can also be open by tapping the DPOS button found in the
Points screen.

Reviewing DPOS Results
The Base Rover Statistics screen can opened by tapping the
blue information panel. An acceptable solution should
have a Fixed solution, a 3dRMS of less that 3 cm (0.10’) and
make use of multiple stations; if this is not the case, the data
can be reprocessed again at a later time by pressing the
ReDPOS button.
DPOS Configuration Screen
Send To DPOS automatically will submit GNSS raw data
to DPOS automatically when an Internet connection is
available.

DPOS - The Filter is Applied to Show Current Project Base Files
Only
With J-Field connected to the Internet, tap the
button to submit the raw data files for the selected base
station session to DPOS. The blue information panel
displays the status of the selected DPOS session.

The
(configuration) button contains various options
for DPOS processing.
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Process all Points with raw GNSS files will submit all rover
raw data files to DPOS for processing even if they have not
been marked for post-processing.
Three processing types exist to determine how to process
the data:
 Base-Processing - base and rover raw GNSS data are
uploaded to DPOS and base-rover vectors are then
processed
 Base Shift - base station data is processed with
CORS data; the base station coordinate and survey
points collected from the base station session will be
automatically adjusted
 CORS-Processing - rover points with raw GNSS files
are processed with CORS data (including your base
data if this option is enabled in the Advanced settings)

Hybrid RTK with DPOS
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Base Rover Statistics Screen
Full DPOS results can be reviewed in the Processed-Point
Info screen by tapping

found in the Point screen.

The detailed use of Processed-Point Info screen is explained
on the following two pages.
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Hybrid RTK with DPOS

59

Screen Anatomy - Processed Point Info Screen

Screen Anatomy - Processed Point Info Screen

Example of a Screenshot for a Base Point

Example Screenshots for a Rover Point

Point Name - The name of the current point being reviewed, this box can be
formated to also display the Code and Description with a long click (notice
the arrow in the bottom left corner)

Use Previous and Next to cycle through the list of surveyed points
The current (radio button is selecting this column) coordinate type for the base and
M-Local - The Multiple Local coordinate/residuals are displayed in
associated rover points is KNOWN (base station was started from a known coordinate). If
this column. M-Local coordinates shift the associated surveyed
the base station was started from an autonomous position this would be labeled AUTO.
points with the same base station session to known coordinates.
(This point does not currently have M-Local coordinates.)
The post-processed CORS solution
for the base station (currently not
selected as the current coordinate)
Note, Audio, Screenshots and
Photos- Tapping these button will
display the point’s Note, Audio,
Screenshots or Photos. These
buttons will only be active when
the point has these attachments.

Indicates this is a Base point
Horizontal and Vertical RMS
Number of Epochs /
Duration (time between
first and last epoch in
seconds)

Attach - Use this button to attach
new media to the point
Map - View this point on the map

Number of GPS +
GLONASS satellites

Edit - Open the Edit Point screen
Delete - Delete this point

The current coordinates; the
coordinates in the selected
column will be used Residuals from the current
throughout J-Field as the coordinate
current coordinates. These
are the coordinates that will
be displayed in map, points
list, exports, etc.

Number of stations used
in this CORS solution

Base Rover Statistics - View the Base
Rover Statics screen for the solution
shown in this column.
60

Info - The info button opens a
text report for the post-processed
solution shown in this column.

Hybrid RTK with DPOS

Add M-Local - Use this button to add the current displayed point
as a M-Local point. Once tapped, you be prompted to select or
enter a coordinate. The translation from the displayed point
(100 in this example) to the enter coordinate will be calculated.
Multiple pairs of points can be added in M-Local to calculate a
best fit translation; hence the term Multiple Local (0-Local has 0
pairs of points, 1-Local has 1 pair, 2-Local has 2, etc.). Select the
M-Local coordinate (radio button set to this column) for any point
to then apply this translation to the selected point and all other
associated points with the base station session.
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Base Type - This box is painted green
when the current coordinate has the base
reference from this type of coordinate.
KNOWN indicates that the base was
started from a known position. If the base
station was started from an autonomous
position this would be labeled AUTO. Tap
this button to view the ABS coordinates
(absolute coordinates, shown in the
bottom screenshot).

Base-Rover Post-Processed Solution with KNOWN Base
(current coordinate in this screenshot)
RTK Solution with KNOWN Base, tap this
box to set the current coordinate to this
coordinate. You will be prompted with
several options:
Yes, For All - This option select this
coordinate type for all points with
associated with this base station
session.
Yes, For All (Auto RTK/PPK) - This
option will use an algorithm to
automatically select the best RTK
or post-processed coordinate for all
points with associated with this base
station session.

Base Type - This box is painted red when
the current coordinate down not have the
base reference from this type of coordinate.
ABS (absolute) coordinates indicate that
the base station coordinates are reference
from a CORS adjusted solution or from local
control points when the M-Local coordinate
is chosen. Tap this button to view the
AUTO/KNOWN referenced coordinates.

CORS Post-Processed Solution

RTK Solution with BCP (Base CORS
Processed) Solution
Base-Rover Post-Processed with BCP (Base
CORS Processed) Solution

M-Local Solution - 3 pairs of
coordinates used in this example. This
solution is always M-Local base-RTK
rover solution.
Tap this column to view the setup
properties of the calculated M-Local for
this point

www.javad.com
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M-Local

Adjusting an autonomous base station to a postprocessed derived position such as OPUS

M-Local coordinates shift the associated surveyed points
with the same base station session to known coordinates.
Some possible uses for M-Local include:
 Adjusting an autonomous base station to local
control points
 Adjusting an autonomous base station to a postprocessed derived position such as OPUS
 Shifting base and rover coordinates to the averaged
coordinate of multiple DPOS base station sessions
Adjusting an autonomous base station to local control
points

View the base point in the Processed Point Info screen and
press the
button. Then choose Manual and
enter the OPUS coordinates. After pressing OK you will
be prompted to enter a point name for the newly entered
coordinates. Once satisfied with the results in the M-Local
screen hit Apply to save and apply the adjustment.

Add M-Local Point Screen - Prompted to select the known
coordinate for point 144

Use the
button found in the Processed Point Info
screen (see previous two pages) to add the current displayed
point as a M-Local point. Once tapped, you be prompted
to select or enter a coordinate. The translation from the
displayed point (144 in this example) to the selected
coordinate will be calculated. Multiple pairs of points can
be added in M-Local to calculate a best fit translation; hence
the term Multiple Local (0-Local has 0 pairs of points, 1-Local
has 1 pair, 2-Local has 2, etc.).

Processed Point Info Screen - The M-Local coordinate is the
current coordinate, 3 pairs of points exist in this M-Local
setup
If the M-Local coordinate is not currently selected (radio
button set to its column), select it for any point from this
base station session to apply its translation to the selected
point and all other associated points with the base station
session.

Alternatively, you could create a new design point with the
known coordinates of the base station prior to entering the
M-Local screen by tapping the
(Add) button found in
the design side of Points list and entering the coordinates
for the new point.
Shifting base and rover coordinates to the averaged
coordinate of multiple DPOS base station sessions
First average the base station coordinates from multiple
base sessions using the CoGo Average function. Next view
each base station point and use the
button to
setup the translations to the averaged coordinate for each
base station point.

M-Local Screen - 3 pairs of points shown
The M-Local Screen displays the translation along the top
row of the screen. Pairs of points can be used Horizontally,
Vertically or only as check points. The residuals for each
pair of points are shown in the middle of the screen. Be
sure to press Apply to save the added points to M-Local
and apply the adjustment to the associated base and rover
coordinates.
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M-Local
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Processed Point Info Screen - Prompt to apply the M-Local
coordinates to all the associated base and rover coordinates
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CoGo

Direct

Code of this point.
Once all the inputs have been entered you may tap the
diagram to preview the results in the map. If satisfied, tap
Create to create the resultant points.

Most CoGo (Coordinate Geometry) functions in J-Field are
rather self-explanatory after viewing their diagrams. CoGo
Direct, Inverse, Shift and Rotate are found in the Basic group
of CoGo functions that will be explained here.

unresponsive. The accuracy of this offset method is limited
by the accuracy of the compass (typically +/- 2 degrees). To
determine a much more accurate position from offsets, use
the CoGo Resection function.

CoGo Direct
Direct calculates the coordinate of a new point (P2) given
the coordinate of a known point (P1), bearing (B) and
distance (D) from P1.
CoGo Basic Functions
In all CoGo function diagrams, labels shown in black are
inputs and labels shown in red are the resultant calculations.
Input points are displayed in green and red points are
resultant points created from the function.

Notice the vertical line in the white box shown between
H,Abs and the input “0.0 ft”:

Clicking on the left side of this white box with H, Abs will
toggle it to the other options of H, Slope and ΔH
Clicking on the right side of this box will allow for the entry
of the value. This functionally is similar in all CoGo menus
when you see a white box separated with a vertical line in
the middle.
The resultant point is shown in the orange box. Clicking on
this box will allow you to edit the Name, Description and
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CoGo
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Set By Compass Screen - Determining the Position of a Tree

Preview Screen of Cogo Direct
The CoGo Direct function can be used to calculate and store
an offset point by using the internal compass and camera to
determine the offset bearing. To determine the bearing to
an object using the compass tap the
button in
the bearing entry screen. Align the cross-hair at the desired
object and press the check hardware button to capture the
azimuth and then tap Apply. Determine the offset distance
to the desired object with a tape measure or laser distance
meter. It is important to check and confirm the compass
calibration is working properly before using this feature;
recalibrate the compass when necessary. Occasionally, the
camera screen may go blank or cause a crash of the system
when using this feature or other features of J-Field that
use the camera. This is a known problem with the current
camera driver. If this happens, reboot the unit. Hold the
On/Off button down to power off the system if becomes
www.javad.com
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Inverse

P1 & P2 can also be entered directly from the keyboard by
typing in the point names. To use this option, long click the
P1 & P2 boxes (notice the small arrows in the bottom left
corner of these boxes).

Resection

Press
to switch the coordinates of P1 & P2. Clicking on
the right side of output boxes such as B, Grid copies the
value of the box into the selected clipboard box.

CoGo Inverse - Ground distance is displayed, tap the D
button to cycle through the other distance type

CoGo Resection
CoGo Resection is found in the CoGo Intersections menu and
can be used to accurately locate an object that is difficult or
impossible to survey directly by surveying 3 points around
that object and measuring the 3 corresponding offset
distances to it.

Inverse calculates the bearing (B) and distance (D) of a line
between two known points (P1 & P2).
The
(multi-select) button can be used as a quicker
method to select both P1 & P2 from the point’s list.

Multi-Select Screen - Selecting Points 103 and 104
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CoGo

In the example shown above, an iron pin at the base of a
tree was located by surveying 3 points around the tree. The
offset distances of 9.92, 4.29 and 2.39 feet were measure
with a tape measure. The small residuals indicate a good
solution (R1, R2 & R3 are all less than 0.03’).
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Shift

Rotate

Multi-Select Screen - Selecting points 1 through 20, notice
the filter used to filter the list to points 1 through 20, the
select all button then is used to select all points

CoGo Shift
CoGo Shift and Rotate are useful for shifting and rotating
design points to desired geodetic surveyed locations.
Upon opening the Shift, Move or Rotate functions you will
be prompted two options: to Create New Points or Move
Existing Points. The Create New Points would need to be
chosen if the desire is to shift surveyed points. Surveyed
coordinates are blocked as options to be shifted is the Move
Existing Points option is selected. The Create New Points
would typically only be desirable and applicable to use if
some object needs to be physically relocated in the field
and the new location needs to be calculated. To adjust
surveyed coordinates from an autonomous base, Real-Time
Position Shift, DPOS or M-Shift should be used.

The
(Delta) button can be used to calculate the delta
between two points, from the first selected point to the
second selected point.

CoGo Rotate
CoGo Rotate is very similar to CoGo Shift. Here the
(Delta) button calculates the angle between the first
selected points to the second selected point with the
selected PB coordinate as the vertex.

The
(Delta DPOS) button is used to recall the DPOS
shift from a base station session. Use this feature to shift
design points. (Automatic shifting of design points created
from CoGo functions is planned to be implemented in a
future version of J-Field.)
Tap the Move button once ready to shift the selected points.

The Multi-Select screen is used to select the points to be
shifted. To select individual points in this screen, use
the
(Check Hardware) button for easier selection of
individual points.
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Appendix A: Creating a RTN Profile
Open the Setup
menu and Create
a new General
Group profile

Enter a name for
the new profile

Select RTK Rover
as the operating
mode

Select the
base reference
frame, typically
NAD83(2011) in
the US

Select NTRIP
Client as the APN
Protocol

NMEA GGA needs
to be enabled if
connecting to
a mountpoint
that is a VRS
(Virtual Reference
Station). Tap Next

Choose Real Time
Network Service
as the correction
type

Enter the Host
Name, TCP
Port, Username
and Password
provided by your
RTN administrator

Select the format
of the mountpoint
and tap Next

Tap New to create
a new RTN APN
(Access Point
Name)

Tap the
(list) button to
view the list of
mountpoints

Find the desired
mountpoint
and tap OK. A
mountpoint with
RTCM 3 format
and both GPS
+ GLONASS is
desirable.

Enter a name for
the new APN
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Appendix A: Creating a RTN Profile

Tap Done to exit
the setup
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